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Sending in your registration card – or registering online at http://www.echoaudio.com/register.html - 
allows us to register key information so that we may handle problems faster and inform you of advance 
information on upgrades and other news.  Thanks in advance for filling out your registration card and 
sending it to us.  We hope you enjoy your Echo product. 
 

Limited Warranty 
 
Echo Corporation warrants this product, when purchased at an Authorized Echo Dealer in the United States 
of America, to be free of defects in materials and manufacturing workmanship for a period of one year from 
the date of original purchase.  During the warranty period Echo shall, at its option, either repair or replace 
any product that proves to be defective upon inspection by Echo.  Final determination of warranty coverage 
lies solely with Echo.  Echo reserves the right to update any unit returned for repair, and reserves the right 
to change or improve the design of the product at any time without notice. 
 
This is your sole warranty.  Echo does not authorize any third party, including any dealer or sales 
representative, to assume any liability on behalf of Echo or to make any warranty for Echo. 
 
Service and repairs of Echo products are to be performed only at the factory (see below) unless otherwise 
authorized in advance by the Echo Service Department.  Unauthorized service, repair or modification will 
void this warranty. 
 
To obtain factory service: 
 
Contact Echo Corporation at (805) 684-4593, 9AM to 5PM Monday through Friday (Pacific Time).  If 
necessary, you will be given a return authorization number.  Products returned without an RA number will 
be refused.  Echo may, at its option, require proof of the original date of purchase in the form of a dated 
copy of the original authorized dealer’s invoice or sales receipt. 
 
Pack the product in its original shipping carton and attach a description of the problem along with your 
name and a phone number where Echo can contact you if necessary.  Ship the product insured and freight 
prepaid to: 
 

Echo Corporation 
6460 Via Real 

Carpinteria, CA 93013 
 

DISCLAIMER AND LIMITATION OF WARRANTY 
 
Echo Corporation makes no other warranties, express, implied, or otherwise, regarding Echo products, and 
specifically disclaims any warranty for merchantability or fitness for a particular purpose.  The exclusion of 
implied warranties is not permitted in some states and the exclusions specified herein may not apply to you.  
This warranty provides you with specific legal rights.  There may be other rights that you have which vary 
from state to state. 
 
In no event will Echo Corporation be liable for any lost profits, or for any consequential, direct or indirect 
damages, however caused and on any theory of liability, arising from this warranty and sale. 
 
©1999 by Echo Corporation 
6460 Via Real 
Carpinteria, CA 93013 
 
Echo® is a registered trademark of Echo Corporation 
Darla24®, Layla®, Gina® and Darla® are trademarks of Echo Corporation 
Windows®, Windows ‘95®, Windows ‘98®, and Windows NT® are registered trademarks of Microsoft, Inc. 

http://www.echoaudio.com/register.html
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Introduction 
 
Thank you for choosing the Darla24 24-bit Multitrack Digital Audio 
Recorder. We think you’ll find Darla24 to be an extremely flexible, high-
performance tool for your computer-based hard disk recording system. 
 
What You Should Have Received in the Darla24 Box 
 
When you opened the Darla24 box, you should have found the following: 
 
 • A Darla24 PCI card wrapped in an anti-static cover 
 • A Darla24 audio breakout box 

• A Darla24 audio connector cable (Please note: The cable included 
with your Darla24 system is a shielded audio cable that has been 
custom manufactured to exacting standards. Use of any other cable, 
such as a computer printer cable, will substantially reduce the 
system’s overall audio quality. See “Installing the Darla24 
hardware” for further details.) 

 • A compact disc containing the Darla24 Windows 95/Windows 98 
Drivers, the Echo Reporter system analysis software, Syntrillium 
Software’s Cool Edit Pro Special Edition multitrack recording 
and editing software, and demo versions of digital audio recording, 
editing, and processing software from a variety of manufacturers  

 • The Darla24 Owner’s Manual 
  
System Requirements 
 
In order to use Darla24 you’ll need the following: 
 

• An IBM-PC or compatible computer with PCI architecture 
expansion slots (version 2.1 PCI BIOS), a genuine Intel Pentium or 
faster CPU, a motherboard with an Intel chipset, and minimum 
64Mb RAM (more highly recommended) running Windows 95 or 
Windows 98 

• A fast, high-capacity IDE or SCSI hard disk drive 
• Peripheral audio equipment, such as a mixer, power amplifier, DAT 

recorder, musical instruments, etc. 
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Darla24 Installation 
 
Complete Darla24 installation consists of performing a system check using 
the Echo Reporter software, installing the Darla24 PCI card, connecting 
the audio interface to the card, installing the Darla24 Windows drivers into 
your system and, if necessary, installing a multitrack audio 
recording/editing application.  
 
 
Running the Echo Reporter Software 
 
The Reporter is designed to provide you with an analysis of your computer 
system’s audio capabilities and its ability to work successfully with 
Darla24. The program looks at such things as your BIOS version, your 
interrupt assignments, and your hard disk’s transfer rate.  The Reporter will 
perform a limited series of compatibility tests.  It cannot guarantee that 
your system will work with Darla24.  The only way to be sure is to install 
the card in your system and see if it works.  Please note that we only support 
Intel CPUs and motherboards with an Intel chipset.  Your system may or 
may not work with other CPUs or chipsets. 
 
Be sure to run the program before attempting to install Darla24 as it can 
help you avoid installation problems down the road. To run the Reporter, 
simply double-click on Install Reporter icon in the Reporter directory of 
the Darla24 CD-ROM. This will install the program onto your hard disk. 
The Reporter will then show up under the Start menu, Programs, Echo 
Audio Utilities. Select The Echo Reporter to launch the program. 
 
Once the program launches, you’ll see the Hard Disk Performance test 
screen. Press the Proceed button to initiate the disk speed test. This test will 
tell you if your hard disk is fast enough to support multitrack digital audio 
and, if so, approximately how many tracks of record and playback you’ll be 
able to achieve. 
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After the test is completed you’ll see a results screen. Many of the 
parameters on the screen are interactive; you can change them to see how 
your disk performs under different conditions.  
 
For example, in the upper right corner of the screen you can see how large 
your hard disk is and how many minutes of recording time it will provide 
for a mono track recorded at 44.1kHz with 16-bit resolution. (Times are 
expressed in Hours: Minutes: Seconds.) Change the Number of Tracks 
field to “2” and you’ll see the maximum length available for a stereo track. 
Change the field to “8” and you’ll see the maximum length you’ll have for 
an eight-track opus. Naturally, these multitrack readouts presume 
uninterrupted, linear tracks. Your music is likely to contain numerous 
snippets of data (e.g., the background vocals will only appear at specific 
moments in time, not continuously throughout the whole tune), so, generally 
speaking, you’ll be able to create longer pieces than the readout indicates. 
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You can adjust the parameters on the Hard Disk Performance 
screen to view your disk’s record and playback capabilities at 
various sample rates and bit-resolutions. 

 
 
You can also change the Size (bit-resolution), Rate (sample rate), and 
Number of Tracks fields. Though the original test was performed with 
default values of 16-bit 44.1kHz, you can easily see your disk’s 
performance reading and writing, say, 24-bit 48kHz data simply by selecting 
those values in the appropriate fields.  
 
About the Playback: and Record: fields under the Max Simultaneous 
Tracks heading: 
 
• At the basic level, these two fields show you how many simultaneous 

tracks of playback and recording your system will support. For example, if 
the readout was “15” for the Playback: field and “8” for the Record: 
field, that means your system is capable of playing back 15 tracks while 
simultaneously recording 8 tracks. Note, however, that the Playback: and 
Record: fields are interrelated: as you change the value in one field, the 
value in the other field is affected. In other words, the values are dynamic. 
You can get a feel for how much overall read/write bandwidth you have by 
adjusting the values in the two fields. By lowering the number of record 
tracks, you’ll see the number of simultaneous playback tracks increase. 
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Similarly, by lowering the number of playback tracks, you’ll see the 
number of record tracks increase. 

 
• The readouts will generally show that you have fewer record tracks 

available than playback tracks. This is because writing data to a hard disk 
is a slower process than reading it back (due to the verify routines used 
when writing to disk).  

 
• The values you see should not be taken as absolute. There are numerous 

conditions that come into play when determining overall performance, 
from operating system overhead to the audio application you’re running 
(different programs use different file management schemes, with some 
more efficient than others). The readouts you get from the Reporter are 
meant to be taken as general guidelines. When you’re actually running 
your audio software, you may get better results than the Reporter tells 
youso don’t run out and buy new hardware just because the Reporter 
tells you your system seems a bit on the weak side. Use your audio 
application in real-world conditions, then make the determination if your 
system can keep up with your needs. 

 
(Conversely, if the Reporter tells you things look really bad, don’t waste 
your time trying to do any serious work. If your hard disk is too slow or too 
small, you’ll save yourself a lot of frustration by upgrading to a big fast disk 
right out of the chutethat is, unless you like random skipping and hiccups 
in your music. And don’t skimp on RAM: we suggest a minimum of 64 MB, 
and load up from there. When it comes to multitrack digital audio, there’s 
no such thing as too much RAM.) 
 
When you’re finished playing around with the disk test parameters, click 
Done to get to the Summary screen. There you’ll see a complete analysis of 
the results of the tests, an explanation of those results, and recommended 
actions (if any are required). If the Reporter alerted you to any problems, 
you should check the appendixes at the back of the Darla24 Owner’s 
Manual for help in isolating the cause of your difficulty and finding a 
solution. 
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The Summary screen tells you if your system can support multitrack audio 
recording as well as alerting you to potential problems. 
 
If your system passed the Echo Reporter test, it’s time to move on to the 
next phase of installation.  
 
The ECHODEL Program 
 
If you have previously installed an Echo audio card, such as a Darla, Gina, 
or Layla, it will be necessary to remove the old drivers before adding your 
Darla24. If you are uncertain as to whether any of these cards have ever 
previously been installed in your computer, it might be wise to go ahead and 
perform the remainder of this step anyway.  It will not harm any of your 
existing system files, and doing so will ensure that you are performing a 
“clean” installation. On the CD that accompanied your Darla24 is a program 
called ECHODEL.EXE. Simply run this program, following the program’s 
instructions.  It will make the appropriate deletions and update your 
Windows system files. (NOTE: It is necessary to run the ECHODEL 
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program anytime you add an Echo audio card to your system, even if you 
are merely exchanging one card for an identical one (such as during a 
warranty exchange).  Be sure to restart Windows after you run the 
ECHODEL program. 
 
System Sounds 
 
There is one final step to perform before installing the Darla24 hardware.  
We suggest that you turn off your Windows system sounds prior to 
installing Darla24.  Because most system sounds are sampled at very low 
sample rates, typically 8 to 11 KHz, each time they are played it will cause 
the sample rate clock on Darla24 to reset to the slower speed. 
 
To turn off the system sounds, first go to the Windows Control Panel, 
which can be found under Settings from the Start button.  On the control 
panel you will find an icon titled “Sounds”.  After double clicking on this 
icon, you will see a window labeled “Schemes” near the bottom of the 
screen.  Click on the small down arrow to the right of the combo-box and 
select the “No Sounds” option.  Then click on the Ok button. 
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Installing the Darla24 Hardware 
 
Once you have run the Reporter software, have verified that there are no 
problems with your system, and have removed any old driver software with 
the ECHODEL program, it is time to install Darla24 into your computer. 
 
IMPORTANT - Unplug your computer and detach all peripherals before 
proceeding with the following steps. 
 
1. Remove your computer’s cover. This operation differs from computer to 

computer. Refer to your computer’s manual for a further explanation of 
this step if necessary. 

 
2. Select the slot into which you will install the Darla24 card. The Darla24 

card is PCI architecture. Inside your computer you will likely find two 
types of expansion slots, ISA and PCI. The PCI slots will be shorter and 
have a higher connector pin density than the ISA slots. You may use any 
of the available PCI slots in your computer for Darla24. Unscrew and 
remove the bracket covering the expansion slot where you would like to 
install Darla24. Place the screw in a safe place, as you will need it later to 
complete installation. 

 
3. Insure that you have fully discharged all static electricity from your body 

before handling the Darla24 card. This can be done through the use of a 
grounding strap or, more simply, by touching your bare hand to the metal 
casing of the computer’s power supply. (For this latter method to work, 
the computer must be plugged in, though not turned on. After you’ve 
discharged your static, unplug the computer before proceeding to the next 
step.) 

 
4. Remove the Darla24 card from its protective anti-static bag. Handle the 

card carefully by its edges and insert it into the selected expansion slot. 
Insure that the card’s edge connector (the protruding edge with the gold 
leads) is seated firmly into the slot. Centering the card over the slot and 
using a gentle rocking motion while pushing downward into the slot 
generally works well. Be careful not to force the card into the slot, or 
bend or twist it while it is being inserted, as this could result in the card 
being damaged. 
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5. Use the screw removed earlier from the protective backplate to attach the 
metal bracket at the back of the Darla24 card to the computer’s rear panel. 

 
6. Replace the computer’s cover and secure it. Reattach its power supply 

cord and reconnect any peripherals that you may have removed prior to 
beginning the Darla24 installation. 

 
7. Locate the Darla24 audio breakout box and the 25-pin audio connector 

cable. Place the breakout box near your computer in a convenient location 
on a level surface. Plug one end of the cable into the 25-pin connector on 
the Darla24 card that now protrudes through the back panel of your 
computer, and secure the cable using the built-in screws located on both 
sides of the connector. Attach the other end of the cable to the rear of the 
audio breakout box and fasten the cable securely with the screws.  

 
NOTE: The cable included with your Darla24 system is a 
shielded audio cable that has been custom manufactured to 
exacting standards. Use of any other cable, such as a 
computer printer cable, will result in unacceptably high 
crosstalk and noise, thereby substantially reducing the 
system’s overall audio quality. If longer cable lengths are 
required, the correct approach is to extend the audio cables 
between the Darla24 breakout box and your 
mixer/amplifier rather than the cable between the breakout 
box and the PCI card. 

 
8. You can now attach external audio devices to the breakout box. Darla24 

can accommodate two analog input signals and can generate eight 
independent analog output signals. 

 
All of the analog inputs and outputs on Darla24 are simultaneously active, 
allowing you to record up to two channels of audio while playing back eight 
channels. 
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Installing the Darla24 Software Drivers 
 
Now that you have completed the hardware installation, you need to install 
the software drivers that allow Darla24 to interact properly with Windows 
95/98 and your audio recording application. 
 
Turn on the power to your computer’s CPU. Caution: Lower the volume on 
your outboard mixer prior to rebooting. The Darla24 hardware can 
produce a loud pop when power is first applied to the computer. After 
Windows 95/98 starts up, it will automatically sense the newly installed 
Darla24 card and indicate, via a pop-up Install Wizard window, that new 
hardware has been found. At this point, you should insert the Darla24 CD-
ROM disc.  
 
If you are using original Windows 95: 
 
Within the Install Wizard window are several options. Select the option 
Driver from disk provided by hardware manufacturer. The computer 
will now prompt you for the location of the driver files. These files are 
located in the root directory of the Darla24 CD-ROM. Click the Browse 
button in the Install Wizard; this will cause the “Install From Disk” 
window to appear. In the field labeled “Copy manufacturer’s files from:”, 
enter the path D:\ (depending on your system configuration, your CD-ROM 
drive may use a letter other than “D”). Click on OK to complete the 
installation. Now turn to page 15. 
 
If you are using Windows 95 OSR2: 
 
After you have inserted the Darla24 CD-ROM disc and clicked Next, you’ll 
see the message, “Windows found the following updated driver for this 
device, Darla24 by Echo.” Click on the Finish button and Windows will 
attempt to locate the drivers on a disk labeled “Echo Install Disk.” 
Unfortunately, no such disk exists. So what you’ll see is a not-so-nice error 
message marked with a big red X. Ignore Windows’ rude behavior and click 
on the OK button. This will bring you to the Copying Files . . . window. 
Within the window is a field labeled Copy Files From: into which you’ll 
need to enter the path name for the Darla24 drivers. Type in the letter name 
of your CD-ROM drive followed by :\ (for example, D:\). Click on OK, and 
Windows will complete the driver installation routine. 
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If you are using Windows 98: 
 
After you have inserted the Darla24 CD-ROM disc and clicked next, you’ll 
see the message, “What do you want Windows to do?” Below that are two 
radio buttons.  If it isn’t already selected, select the one labeled “Search for 
the best driver for your device (Recommended)”.  Click on the Next button 
and a dialog will appear with several check boxes indicating places where 
Windows will look.  If you are installing from a CD-ROM drive or from a 
floppy disk, click on the appropriate box.  Be sure all others are unchecked.  
Click on the Next button and Windows will locate the drivers on the install 
disk and show you the Copying Files . . . window as it completes the driver 
installation. 
 
After the drivers are installed, you should verify that Windows recognizes 
them. You can do this by checking in the Windows Control Panel as 
follows: 
 
Begin by clicking on the Windows Start button. Then select Settings, 
followed by Control Panel. Now double-click on the icon labeled System. 
At the top of the System window, you will see a tab labeled Device 
Manager; click on the tab. Now locate the line labeled Sound, Video, and 
Game Controllers. Double-clicking on the “+” to the left of the line’s 
associated icon should reveal the line Darla24 by Echo; double-click on 
that line.  The “Holy Grail” that we’re searching for is a message that, if 
everything is in working order, should now appear on your screen. In the 
center of the Darla24 Properties window will be a section called “Device 
Status.” Look for a message that reads “This device is working properly.” If 
you see it, give yourself a hearty pat on the back for a job well done!  
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Proper installation of the Darla24 drivers will result in the 
message, “The device is working properly.” 
 
If the message does not appear, check Appendices A, B and C for help in 
isolating the cause of your difficulties. 
 
You can now exit back to the Control Panel window to check the 
Darla24 audio input and output devices that are available. In the Control 
Panel window, locate the Multimedia icon and double-click on it. This 
will bring the multimedia Properties window into view. Select the 
Audio tab to see a list of available playback and recording devices in the 
Preferred Device fields. 
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Darla24 Audio Input & Output Devices 
 
The Darla24 driver installs into your computer as a series of stereo .WAV 
devices. Pulling down the Preferred Device menu in the Control 
Panels/Multimedia/Audio Playback section will reveal the available 
Darla24 devices. You will be able to select from: 
 
Darla24 1/2 Analog Playback  
Darla24 3/4 Analog Playback  
Darla24 5/6 Analog Playback  
Darla24 7/8 Analog Playback  
 
In the Recording section, the following choice will be available: 
 
Darla24 1/2 Analog Record  
 

 
You can view the Darla24 input and output 
devices in the Multimedia Properties/Audio 
window.  
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You’ll find these same input and output options available when using your 
audio record/editing software, with the devices assignable on a per-track 
basis. See your software owner’s manual for details on how to make these 
device assignments. Instructions for making these assignments in Cool Edit 
Pro Special Edition can be found on page 32 of this manual. 
 
This completes the installation of the Darla24 hardware and software.  
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The Echo Console  
 
Included with your Darla24 is a “virtual control surface” application called 
The Echo Console. The Console allows you to control the audio I/O and 
clocking functions of Darla24, and it brings these controls to a single easy-
to-use location.  From the console you can control input and output levels as 
well as adjust input monitoring.  
 
The Echo Console software was automatically installed at the same time 
that you installed the Darla24 drivers for Windows 95/98.  If installation 
was successful, you should see a capital letter D in your Windows ‘95/98 
taskbar (typically in the bottom right-hand corner of your screen).  Clicking 
on the “D” will activate the console program.  It should look like this: 
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The console functions are grouped into three areas: inputs (in the upper left 
corner), monitors (directly below the inputs that are being monitored), and 
outputs (on the right hand side).  The controls for a particular 
function/stereo pair are then further grouped into a box that contains 
selection buttons, a slider, and other controls and displays as determined by 
the function. 
 
 
The File Menu 
 
At the top left of the Console window you will find the File menu. By 
selecting the File menu, several configuration options become available to 
you.  The first menu option is “New Console”.  The New Console option 
allows you to create an additional iteration of the console program.  In this 
way, multiple devices (Laylas, Ginas or Darlas) may be controlled using 
their own dedicated console. 
 
The second option under the File menu is “Exit” which closes the current 
instance of the console. 
 
 
The Edit Menu 
 
The “Appearance” option, first on the Edit menu, lets you customize the 
look of your console. You can change the color of each of the console 
elements, change the fonts used, or choose to abbreviate labels. You may 
even want to produce multiple color schemes to help recognize the device 
that is being controlled. A number of preset color schemes are included. 
 
The second option on the Edit menu is “Input Levels.” This option is not 
available on the Darla24 card. 
 
The third option on the Edit menu is “Nominal Levels.” This option 
produces the following window: 
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The Nominal Levels window lets you specify what type of equipment is 
connected to each input and output of Darla24.  In general, consumer audio 
gear runs at the –10 dBV level, while professional equipment runs at +4 
dBu.   
 
The fourth option under the Edit menu is “Mixer Device.” The Mixer 
Device option lets you choose the device that the current iteration of the 
Console program controls. So, if you have more than one device (Layla, 
Gina, Darla or Darla24) attached to your system, you can use the same 
console to control them all using the Mixer Device option to control which 
device is currently selected. 
 
 
The Session Menu 
 
Users now have the ability to save and restore any number of different 
console states.  A console state contains the state of each user-selectable 
console setting excluding color scheme and font. 
 
The “Open” option, first on the Session menu, lets you open a previously 
saved session. 
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The “Save” option, second on the Session menu, lets you save any changes 
made to the current session. 
 
The “Save As…” option, third on the Session menu, lets you save any 
changes made to the current session under a different name. 
 
The “Delete…” option, fourth on the Session menu, lets you delete any 
session. 
 
The “Select Default Settings” option, fifth on the Session menu, lets you 
change to default session settings.  This is not the same as opening the 
default session!  Rather it is a set of pre-defined settings. 
 
The “Auto Save Default Session” option, sixth on the Session menu, 
automatically saves any changes made to the default session whenever the 
console is closed or a new session opened without prompting the user with: 
 

 
This option insures that any changes you make to the default session will 
never be lost.  When a check appears on this menu item, the feature is 
enabled.  
 
The last option on the Session menu is a list of the last sessions opened.  
You can quickly open a previous session by simply clicking on its name in 
the list.  For those who like using the keyboard, pressing the corresponding 
number (displayed with an underline before the session name) also works. 
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The Monitors Menu 
 
The “Group Mode” option, first on the Monitors menu, is not available for 
Darla24. 
 
The “In-Line” option, second on the Monitors menu, is not available for 
Darla24. 
 
Console Controls 
 
Let’s take a look at the control surface.  The input controls are located in the 
upper left portion of the console surface.  In the center of each input control 
is a pair of level meters. 
 

 
Unlike the console for Gina and Layla, Darla24 has no input controls, just 
the level meters. 
 
Monitor Controls 
 
Below the input channels are the input monitor controls.  The input monitor 
controls allow you to monitor the record input signal via any of the 
available outputs on your Darla24.  Each input channel pair has a 
corresponding monitor output pair directly below it on the console.  The 
monitor controls look similar to the controls for input.  The mute (M) and 
solo (S) buttons are found at the top, and the gang (G) selection button is at 
the bottom.  In addition, a pair of slider controls is available for setting the 
levels of the monitor signals.  Instead of level meters, the monitor control 
has a series of numbered buttons.  These buttons allow you to select which 
output channel pair controls are displayed. 
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The monitors are one of the most powerful functions of the console. When 
you are recording, these controls allow you to set the level at which each 
input signal will be monitored at each of the outputs, independent of the 
main output level control.  
 
When setting a monitor level, you must first select the input that will be 
monitored, and then select the output for which you will set the monitor 
level.  Selection of the input is really just a matter of using the correct 
monitor control box.  A monitor setting will always affect the input pair that 
is directly above it.  To set the monitor for inputs 1/2, for example, simply 
go to the monitor control directly below inputs 1/2 and click on one of the 
four buttons found in the center of the control. 
 
Let’s say you want to set the level at which input pair 1/2 is monitored for 
each of the four stereo analog output pairs on Darla24.  You would first find 
the monitor control that corresponds to inputs 1/2 (the control on the far left, 
directly below the input control for channels 1/2).  Clicking on the button 
within this box labeled “1/2” causes the control box to display the currently 
selected levels at which inputs 1/2 are being monitored at outputs 1/2.  
Clicking on the button labeled “3/4” would cause the control box to display 
the currently selected levels at which inputs 1/2 were being monitored at 
outputs 3/4.  You can move through the remaining buttons, setting the level 
at which inputs 1/2 are monitored at each of the four output pairs.  The 
console program remembers any settings that you make, and all settings for 
all outputs are maintained independently.  
 
Remember that all of the inputs are continuously monitored by all of the 
outputs at some level.  The degree of attenuation (or muting) of that level is 
set by the monitor controls.  The console program constantly maintains a 
level setting for each of the 8 monitor paths it controls.  Clicking on an 
output selection button simply selects the settings that are displayed. 
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Output Controls 
 
The right hand side of the console is dedicated to the controls for output 
channels one through eight.  The available controls are: Gang, Mute, Solo, 
meter on/off and volume slider. 
 
Adjusting Record and Playback Levels 
 
Darla24’s output volume adjustments are made in the digital domain.  When  
you lower a volume slider; you are actually decreasing the number of 
available bits, thereby taking away from the potential dynamic range of the 
system.  To avoid this, we suggest that whenever possible you leave the 
output sliders set to their maximum positions, and perform any necessary 
attenuation on your external mixer.  When the Darla24 playback volume 
controls are set to maximum and the input signal approaches the maximum 
pre-clipping level, you can achieve the full 24-bit dynamic range of the 
system. 
 
Synchronizing Multiple Devices 
 
Darla24 is designed to work alongside other audio equipment within a 
complete Windows system.  If you are planning on using Darla24 with other 
audio equipment, please note the following:  
 
The Darla24 Windows drivers (echogals.drv and echogals.inf) included in 
this package supports multiple Darla24s within the same system.  In 
addition, your new Darla24 will operate with Layla, Gina and Darla.  
Darla24 can also peacefully coexist with audio equipment from other 
manufacturers, but be aware that operating alongside another product is not 
the same as operating with it.  Darla24 does not support external 
synchronization.  In order for accurate synchronization to occur, all audio 
products in your system must support some form of synchronization such as 
Midi Time Code, S/PDIF or Word Clock.  Without such synchronization, 
the individual pieces of equipment will act independently of each other.  
This scenario may be fine for some musical applications; however, it is not 
appropriate for situations where sample-accurate synchronization is 
required.  
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Console Keyboard and Mouse Shortcuts 
 
To navigate between control groups: 
Ctrl + Tab   Move to next control group. 
Ctrl + Shift + Tab Move to previous control group. 
 
To navigate between controls within a control group: 
Tab    Move to next control. 
Shift + Tab   Move to previous control. 
Ctrl + S   Toggles between left & right Solo buttons. 
Ctrl + M   Toggles between left & right Mute buttons. 
Ctrl + A   Toggles between left & right Trim buttons. 
Ctrl + T   Toggles between left & right +10/-4 buttons. 
Ctrl + G   Select the Gang button. 
Enter    Toggles the state of any selected control. 
 
To control volume sliders: 
Right mouse click  Allows user to type in the desired level. 
Ctrl + left mouse click Set volume level to zero. 
Ctrl + ↑↑↑↑   Raise volume of selected control about 5 dB. 
↑↑↑↑    Raise volume of selected control about 1 dB. 
Ctrl + Alt + ↑↑↑↑  Raise volume of selected control about 0.004 dB. 
Ctrl + ↓↓↓↓   Lower volume of selected control about 5 dB. 
↓↓↓↓    Lower volume of selected control about 1 dB. 
Ctrl + Alt + ↓↓↓↓  Lower volume of selected control about 0.004 dB. 
 
Individual channel titles are customizable.  To change the text of a channel 
title (i.e., In 1/2, Mon 3/4, Out 5/6, etc.), right mouse click on the channel 
title and type in the desired text. 
 
 
 
 
Additional Configuration Settings 
 
In addition to those settings that can be made using the Console program, 
there are a number of other configuration options you can access. These are 
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found on the Windows Control Panel.  To access these controls, begin by 
pressing the Windows Start button.  Select Settings, then Control Panel. 
In the Control Panel window, locate the icon for System, and double-click 
on it.  Click on the tab titled Device Manager. Now locate the line titled 
Sound, video and game controllers.  Finally, locate the line titled Darla24 
by Echo, and double-click.  This will bring up the Darla24 Properties 
window, which we saw briefly at the conclusion of Darla24 installation.  
 
We have previously seen the “General” screen, so let’s move on to the 
“Settings” screen by clicking on the tab labeled Settings. 
 

 

 
 
The “Monitor During Playback” Control 
 
In the default mode, Darla24 allows you to monitor your input signal 
whether you are recording, playing back, or simply idle.  In some situations, 
such as when performing punch-in recording, it may be desirable to have the 
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input signal muted until Record is enabled.  In the Darla24 Properties 
window that appears you’ll see a checkbox labeled Monitor During 
Playback.  Uncheck the box to disable input monitoring; recheck it to once 
again enable input monitoring.  Monitoring controls are also available on 
the Echo Console. 
 
SAW Compatibility Mode 
 
When using Darla24 with the Software Audio Workshop (SAW) program 
from Innovative Quality Software, there are some special considerations 
that must be accommodated by the Darla24 driver.  SAW expects an equal 
number of inputs and outputs on Darla24.  For SAW compatibility, the 
driver creates a non-functional mirror of input channels 1 and 2 (making an 
equal number of ins and outs). To insure that Darla24 will operate properly 
with SAW, check the box labeled SAW Compatibility Mode.  (Note:  This 
option should only be checked when Darla24 is being used with the SAW 
application.) 
 
Show Echo Console on the Taskbar 
 
The last selection on the Settings screen allows you to determine whether 
the Echo Console program will occupy a space on the Windows taskbar (the 
“D” in the bottom right-hand corner of the Windows desktop).  
 

 
Checking this option enables this feature, unchecking it disables it. 
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ASIO Driver Installation 
 
The ASIO driver is automatically installed on your system at the same time 
the Echo Layla/Gina/Darla/Darla24 driver is installed.  To use it: 
 
1. If you already own a copy of Steinbergs’ VST program, skip to step 3. 
2. On the installation CD, run the program: 

\Audio Software Demos\Steinberg\CubaseVST demo\VSTdemo.exe 
which will install a fully functional demo of this program.  What fully 
functional means is that all of the features are in place so you can really 
put the program through its paces.  The only thing disabled is the ability 
to save.  If you want save your work, you must buy the program. That's 
the way it works. 

3. Start CubaseVST or CubaseVST demo 
4. Go into menu Audio - System.  Select the "ASIO Echo 

Gina/Darla/Layla" option in the ASIO device combobox. 
5. Click the OK button. 
6. It is best to load or create a song and verify that the driver is functioning. 
7. The default latency is about 187 milliseconds using an 8k buffer.  This 

may be changed in the dialog box found in menu Audio - System then 
select the ASIO Control panel button.  Choose a buffer size between 1K 
and 64K.  The smaller the buffer, the lower the latency.  At 1K, the 
latency is 25 milliseconds. 

8. You can change the data and buffer sizes in the ASIO Control panel 
without leaving VST provided you respond consistently to the dialog 
boxes.  In other words, if you change the buffer size in the ASIO Control 
panel and select the Ok button, you must also press the Ok button in the 
next dialog which says: 
"Change ASIO Device:  All Fx and Bus Settings will be lost!". 
Choosing the Cancel button will result in no more sound until you exit 
VST and restart it. 

9. When using the ASIO driver with more than one card, you must be sure 
they are synched using either the Word Clock (Layla only) or S/PDIF 
(Layla & Gina).  This involves the appropriate cabling and enabling the 
clocks in the console(s).  See section “The Clocks Settings” in the Gina 
or Layla manual for details.  If you fail to do this, the driver will now 
display a warning dialog.  You will not be able to continue until the 
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problem has been corrected.  Therefore, you cannot use VST with 
multiple Darla24s because they do not support external synchronization. 

10. When running VST selecting menu Options - Reset Devices followed by 
pressing the Play button results in no sound.  Simply press the Stop 
button twice to reset the position pointer to the beginning of the buffer.  
Then press Play and sound will resume. 
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Installing Cool Edit Pro Special Edition  
 
Included with your Darla24 system is a special version of Syntrillium 
Software’s Cool Edit Pro, a powerful multitrack audio recording and editing 
application. To install the software: 
 
1.  Insert the Darla24 CD-ROM. 
 
2.  Press the Start button, and select Run… from the menu. Now select 

Browse… At the top of the window that appears, you will see a box 
labeled Look In:. Clicking on this box will result in a list of your disk 
drives to appear. Select your CD-ROM drive. On the CD-ROM is a 
folder called Syntrillium; double-click on this directory to open it. Now 
locate the file in the Syntrillium directory called SETUP.EXE. Select this 
program and run it. 

 
The SETUP program will copy all of the necessary files to your hard drive. 
It will also add a program group called “Cool Edit Pro  Special Edition” 
to the Program listings available from the Start button menu. 
 
Cool Edit Pro  Special Edition comes with very thorough on-line 
manual/help, so you’ll be able to get up and running with a minimum of 
hassles (hopefully none at all!).  We do, however, suggest that you 
familiarize yourself with the items under the Quick Reference heading in 
the program’s Help menu. 
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Cool Edit Pro: Assigning Darla24’s Inputs & 
Outputs 
 
Darla24’s inputs and outputs are assigned to tracks in two different ways, 
depending on the viewstereo waveform or multitrackin which you are 
working. In the stereo waveform view, select Options/Settings/Devices; in 
the window that appears you can define the Waveform Playback and 
Waveform Record devices. Simply highlight the Darla24 inputs and 
outputs you wish to use in the appropriate fields. These settings will apply 
for all files that you play or record when in the stereo waveform view. These 
device settings are saved as Cool Edit Pro preferences; as such, they will be 
used for all subsequent sessions until you change them. 
 
In the multitrack view, the inputs and outputs are assigned on a per-track 
basis. Before making assignments, however, you’ll need to set up the 
Preferred Multitrack Devices. To do this, click on either of the small 
numeral 1s at the far left of the track display; doing so will bring up the 
Playback Device window. Click on the Device List button; you’ll see a list 
of Preferred Multitrack Devices. In the Playback fields, assign Darla24 
analog playback devices 1/2, 3/4, 5/6, and 7/8 into the 1st, 2nd, 3rd, and 4th 
fields, respectively. In the Record fields, assign Darla24 1/2 Analog 
Record to the first. Click Okay on each window to back out to the 
multitrack view screen. These device assignments are saved as Cool Edit 
Pro preferences, and will be used each time you open a new session. 
 
To make the playback and record device assignments for a specific track, 
click anywhere in the track’s blue-gray area at the far left of the track 
display. This will open the Track Info window. Click on the arrows in the 
Playback Device and Record Device fields to select the desired inputs and 
outputs.  
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Cool Edit Pro: Optimizing Multitrack 
Performance 
 
Background mixingthe process Cool Edit Pro uses to allow a large 
number of tracks to play simultaneouslyrequires significant processing 
power from your computer. With larger sessions, your computer may 
become so occupied with mixing that you experience audio dropouts in 
multitrack playback. This will usually happen because the background 
mixing is not sufficiently complete (watch the Mix Gauge) before playback 
is initiated. There are a few things you can do to help remedy this; however, 
be aware that if you have a slower machine, you may still have to wait for a 
time before hitting the Play button when working with very large sessions. 
 
The settings in Options/Settings/Multitrack play a big part in optimizing 
the background mixing processes. In particular, pay attention to the 
Playback Buffer Size and the Background Mixing Priority Level. The 
key to determining how to adjust these settings is to watch the Mix Gauge. 
As a general guideline, if you notice dropouts occurring even though the 
Mix Gauge seems reasonably complete (the meter is beyond ¾ of the way 
filled), try reducing the Playback Buffer Size, and raising the Background 
Mixing Priority Level (higher values reduce the priority level). 
Conversely, if you notice dropouts and see that the Mix Gauge is hovering 
around the bottom “empty”), try increasing the Playback Buffer Size and 
lowering the Background Mixing Priority Level.  
 
The goal in adjusting these settings is to achieve a balance between values 
large enough for the program to work properly and low enough to conserve 
the computer’s resources. The Background Mix Priority must be high 
enough (lower settings produce a higher priority) to keep the mix ahead of 
playback, but not be so high as to adversely affect performance (by 
consuming too much of your computer’s resources). In short, the lower you 
can keep this setting while still keeping the Mix Gauge reasonably filled 
the better. Raising the buffer size consumes more of your computer's 
memory, so setting this too high can negatively affect performance.  
 
When adjusting these settings, do so by small amounts, using decimal 
increments/decrements. Also, note that the settings will produce different 
results from session to session. As the number of tracks and the number of 
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output devices vary, so may the settings you’ll need to use to maximize 
performance. 
 

 
Use the Multitrack Settings shown above as a starting place when 
adjusting your system to optimize the performance of Cool Edit Pro. 
 
Cool Edit Pro will take more time performing background mixing when you 
have your tracks assigned to multiple sets of Darla24’s outputs. In this 
scenario, Cool Edit Pro creates a separate mix for each output device (each 
Darla24 channel-pair). This additional mixing demands more processing 
power from your computer, resulting in longer mix times and possible 
skipping during playback. If your system is performing sluggishly, you can 
temporarily assign all tracks to a single channel-pair while monitoring to 
speed things up. When doing so, it is recommended that you check 32-bit 
Pre-mixes mode in the Settings/Multitrack screen. When monitoring to 
multiple output devices, 16-bit Pre-mixes is the recommended mode.  
 
Note that the 16-bit and 32-bit modes are playback settings only; that is, the 
data on your disk remains at the resolution at which it was recorded. 
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Contacting Customer Service 
 
If you experience any trouble with your Darla24 system please go to the 
support area of our website at www.echoaudio.com and check out the 
troubleshooting FAQ’s we have there.  If you can’t find a solution to your 
problem there, please fill out the provided technical support email form.  
This form will be sent to our technical support staff and they will respond to 
you quickly.  Please fill out the form completely.  We will not respond to 
you unless you fill out the form in its entirety.  We cannot help you unless 
you give us the required information. 
 
We do ask you to please read through this manual and the support area of 
our website before contacting us. You may find an answer to your problem 
using the Appendices in the Darla24 owner’s manual and/or Cool Edit Pro’s 
on-screen help. 
 
Thank you for buying Darla24! 
 
Note, too, that all Cool Edit Pro  Special Edition support issues are 
handled solely by Echo Corporation. Please do not call Syntrillium 
Software for technical support. If you do, they will simply refer you to 
Echo Corporation for help. 
 

http://www.echoaudio.com/
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Appendix A: The Echo Reporter  
Troubleshooting Guide 
 
 
After you run the Reporter program, your summary may contain one or 
more of the following problem/error messages. Consult the table below for 
suggestions on interpreting the messages and finding solutions. 
 
Message... 
 

Problem... What to do... 

* The Echo line of sound 
cards require Windows 95 
or Windows 98 

Your computer is using a 
Windows 3.xx or Windows 
NT operating system  

The Echo Reporter and  
Darla will only operate in 
Windows 95 or Windows 
98. You must update to one 
of these operating systems. 
 

* The Echo Reporter has 
found that your system does 
not have a PCI BIOS. To 
alleviate this problem, 
please purchase a PCI 
system, version 2.1 or later 

Your computer does not 
have an operational PCI 
Bios 
 

Upgrade to a PCI computer 
with BIOS version 2.1 or 
higher 

 
* The Echo line of sound 
cards require PCI version 
2.1 or later. To alleviate 
this problem, please 
purchase a PCI system, 
version 2.1 or later 
` 

 
Your computer has a PCI 
BIOS, but it is version 2.0 
or earlier 

 
Upgrade to a PCI BIOS 
version 2.1 or higher 

*The Echo Reporter has 
determined that your 
system has no free 
interrupts. The Echo line 
of sound cards require one 
interrupt to be available 
for use. To alleviate this 
problem, try removing 
unnecessary or 
infrequently-used 
peripheral devices 

Your computer has no free 
interrupts. Interrupts 0-15 
are either being used or are 
reserved by other 
applications or drivers 

There is no single direct 
solution to this problem. 
Generally, you will need to 
free an interrupt by 
eliminating a peripheral 
device. Consult Appendix C 
for suggestions on making 
an interrupt available for 
Darla24 
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*The Echo Reporter has 
found that none of the hard 
drives that were tested meet 
minimum performance 
standards with respect to 
transfer rate. Though your 
system supports the Echo 
line of sound cards, we 
recommend that you 
upgrade your hard drive(s), 
as your existing drive(s) are 
not capable of sustaining 
the minimum transfer rates 
required for reasonable 
performance 
 
 

Your computer has no 
physical hard drives that test 
at a transfer rate better than 
500Kb/second. This will 
seriously hinder the 
performance of Darla24 and 
will greatly limit the 
activities that you can 
perform. 

First, verify that 32-bit disk 
access is enabled. This is 
done under the heading 
Performance in System 
Properties. The only other 
solution is to add a faster 
hard disk to your system.  

*The Echo Reporter has 
found that your system may 
not be equipped with a 
Pentium (or faster) 
processor. The algorithm 
we are using for processor 
detection is known to return 
faulty values for many of 
the AMD, Cyrix, and other 
non-Intel chips, so be sure 
to double-check this 
warning against processor 
identification that your 
machine displays each time 
you boot up. It is essential 
that your machine be 
equipped with an Intel 
Pentium or Pentium II 
processor. 

Your computer appears to 
have a microprocessor that 
is not fast enough to 
properly carry out the 
necessary operations. If 
your computer’s 
microprocessor is 
characterized as “Pentium-
class,” you may want to go 
ahead and try working with 
Darla24 to see if your 
results are satisfactory. 

The only way to fix this 
problem is to upgrade your 
microprocessor to an Intel 
Pentium or Pentium II 
processor. 
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Appendix B: General Troubleshooting Guide 
 
 
Problem: After installing Darla24, one or more of your peripheral devices 
no longer functions properly. 
 
Solution: During the installation of your Darla24, it is possible that an 
interrupt conflict was created. Please see Appendix C: Resolving 
Interrupt Conflicts for more information on this topic. 
 
Problem: You installed Darla24 and restarted Windows. Now Windows 
indicates that it has found new hardware and wants you to install a driver 
for it. This hardware was working perfectly well before you installed 
Darla24 and the driver for this hardware was already installed. 
 
Solution: It is possible that during the installation process you moved an 
existing card from one slot to another. Windows keeps track of installed 
devices, not only by peripheral type, but also by physical location. In 
moving a card from one slot to another, Windows will no longer recognize 
the card as one for which a driver is installed. You must re-install the driver 
for the card that was moved. 
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Appendix C: Resolving Interrupt Conflicts 
 

While Plug-and-Play is often called “Plug-and-Pray,” it actually works 
quite well most of the time. We estimate that 95% of Darla24 installations 
will go without a hitchthat Plug-and-Play will properly assign resources 
to your card without any conflicts. The other 5% of you will likely 
experience interrupt problems caused by older, non-Plug-and-Play cards 
that are installed in your system. These problems can manifest themselves 
by causing your new Darla24 to not function properly; in some instances, 
devices will fail that were previously working just fine. 
 
If you are having problems with your computer after installing a new 
Darla24 card (or if you are unable to successfully install the card at all), 
please read the sections below describing what interrupts are, how they are 
assigned, and how to work around interrupt conflicts. Hopefully, we’ll be 
able to help you solve your problem without too much trouble.  
 
 
What is an Interrupt? 
 
A computer has two ways of telling when a device, such as an audio card, is 
ready to exchange data with a program. One way is to have the computer 
periodically ask or “poll” the device to see if it’s ready to transfer new data. 
Since it is important to do the transfer as soon as it is ready, the program 
must poll the card quite often, which wastes the computer’s resources. 
 
The other method is to have the card “interrupt” the program when it is 
ready to transfer data. It does this by sending a signal over one of the many 
interrupt wires connected to the slot into which it is plugged. PC’s have 16 
possible interrupts (0 to 15), five of which are reserved by the motherboard 
for the keyboard, system timer, etc. 
 
 
ISA and PCI Interrupts 
 
There are two types of expansion connectors found on today’s computers. 
The older style connectors are called ISA (for Industry Standard 
Architecture) connectors. ISA connectors have 11 of the 16 PC interrupts 
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wired to them. Older ISA cards (also called “legacy” cards) have you select 
which interrupt is used by configuring jumpers on the card. Newer Plug-
and-Play ISA cards have their interrupts selected by either the computer’s 
BIOS (the built-in program that starts the computer) or by Windows 95/98. 
 
The newer PCI (Peripheral Connect Interface) bus transfers data faster than 
ISA and was designed to support Plug-and-Play from the start. PCI 
connectors have only four interrupts wired to them (A, B, C, and D). 
However, these interrupts can be shared by more than one PCI connector 
slot and each connector’s interrupt can be assigned or “steered” to one of 
the 11 available PC interrupts by either the BIOS or Windows 95/98. As far 
as the user is concerned, PCI interrupts use the same numbers and are 
assigned the same way as Plug-and-Play ISA interrupts. Note, however, that 
a PCI card can share an interrupt with another PCI card but not with an ISA 
card. 
 
 
Plug-and-Play and Interrupts 
 
When your computer first starts up, the BIOS will check each connector slot 
to see if a Plug-and-Play card is installed. Each Plug-and-Play card has built 
into it a list of what resources it requires including how many interrupts it 
needs and which ones it can use. The BIOS will then configure each card 
and, if needed, assign an appropriate interrupt. It does this for both ISA and 
PCI Plug-and-Play cards. Windows 95/98 will also check for and configure 
Plug-and-Play cards, possibly changing some of the settings to suit its 
needs. 
 
 
Legacy Cards and Interrupt Conflicts 
 
Problems can arise when the system contains older “legacy” cards with their 
jumper-configured (or possibly hard-wired) interrupts. The computer’s 
BIOS and Windows 95/98 have no automatic way to detect these cards and 
determine which interrupts, if any, are being used. For example, you may 
have a MIDI card installed with its jumpers configured to use IRQ 9. Since 
the BIOS cannot detect the legacy card it will consider IRQ 9 to be a free 
interrupt. Consequently, it may assign IRQ 9 to Darla24. The next time you 
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try and use your MIDI card or play back audio via Darla24, neither device 
will function properly.  
 
Or, maybe you have a SCSI card that had previously been assigned to IRQ 
10. The BIOS may now decide to assign IRQ 10 to Darla24, and move the 
SCSI card to IRQ 9. An interrupt conflict now exists between the SCSI card 
and the older MIDI card. In this case, you’re probably cursing at your new 
card (and possibly us) for messing with your SCSI interfaceafter all, 
everything worked fine before the new card was installed. Since we’re quite 
sensitive about being yelled at, we want to help you resolve any conflicts (of 
the interrupt variety) you may be having. 
 
 
Resolving Interrupt Conflicts 
 
Although there is no way to automatically detect legacy interrupts, 
Windows 95/98 and some BIOS’s allow you to reserve specific interrupts 
for legacy use. Once an interrupt is reserved it will not be assigned by Plug-
and-Play to another card. 
 
The first thing to do if you think you have an interrupt conflict is to 
determine which interrupt and which legacy card is causing the problem. To 
do this, run the Reporter software that came with your Darla24 card. For 
now, you can skip over the hard disk performance test since it has nothing 
to do with interrupts. Once the Reporter has finished the diagnostic routine, 
it will provide you with a list of all of the interrupts that Windows 95/98 
recognizes are in use and the cards or resources to which they are assigned. 
Write down the interrupts that are listed and the devices that are assigned to 
them. Pay particular notice to the interrupt to which Darla24 is assigned.  
 
Once you know which interrupt your Darla24 is trying to use; you need to 
locate which legacy card is potentially causing the conflict. To do this you 
will need to dig out the manuals for whatever cards are installed and 
examine the jumper settings to determine which interrupts, if any, are used. 
Hopefully, at this point you will find an offending card that was not listed 
by the Reporter software but is using an interrupt assigned by Windows to 
another device.  
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If you have lost your manuals and are having trouble figuring out which 
card may be causing a problem, you can try the brute force approach. 
Remove all legacy ISA cards from your system and then re-install them one 
at a time until the system quits working. The card that makes the computer 
stop working correctly will be the one that needs to be dealt with. 
 
Once the offending card has been identified you have a few different 
options. One option is to simply remove the card from your system. 
However, you’ve likely got the card in there for a reason, so unless it’s an 
old sound card you don’t care about keeping, you’ll probably want to use an 
approach to remedying the problem that allows the card to remain in the 
system. 
 
Another option is to change the IRQ on the legacy card to an IRQ that isn’t 
currently being used as reported by the Reporter program. While this may 
fix the problem at hand, the next time you add another new Plug-and-Play 
card you may wind up with another conflict. If you choose this option it is 
still a good idea to reserve the IRQ as described below. 
 
 
Reserving an IRQ within the BIOS 
 
Other than removing the offending legacy card, the next most effective 
method is to reserve the IRQ for legacy use within your BIOS. To do this 
you will need to enter the BIOS configuration screen when your computer 
first starts up. This is usually done by pressing the Delete key or F1 key 
right after the memory test during the boot-up routine. Once you’re in the 
BIOS control panel, check to see if you are given the option of manually 
configuring your interrupts. Some BIOS’s, such as those from Award, allow 
you to choose between “Plug-and-Play” and “legacy ISA” for each interrupt. 
If you select “legacy ISA” for the interrupt that is being used by your legacy 
card, the BIOS will know not to assign that interrupt to a Plug-and-Play 
card.  
 
Unfortunately, many BIOS’s don’t support this capability. If your BIOS is 
one of those, don’t worry: You still have another option. 
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Reserving an IRQ within Windows 95/98 
 
Windows 95/98 also allows you to reserve interrupts for legacy use. In most 
cases this works just as well as reserving the IRQ in the BIOS. However, 
you may still have problems if you boot up an older version of DOS from a 
floppy where Windows 95/98 can’t do its Plug-and-Play magic. To reserve 
an IRQ within Windows 95/98 do the following: 
 
1.  Click on the Start button and select Control Panel under the Settings 

option. 
2.  Double click on the icon labeled System. 
3.  Select the tab labeled Device Manager and click the Properties button. 
4.  Select the tab labeled Reserve Resources and make sure that Interrupt 

Request is selected. 
5.  Click on the Add button and enter the IRQ that is being used by your 

legacy card. 
6.  Windows may prompt you that the IRQ is currently in use by another 

device. Click on Details to see which device Windows currently thinks is 
using this IRQ. It should be Darla24 or whatever device is currently 
conflicting with your legacy card. If that is the case, go ahead and 
reserve the IRQ. 

7.  When Windows asks, reboot your machine. When Windows restarts your 
Plug-and-Play cards will not be assigned to the reserved IRQ. 

 
Hopefully, your system will now be functioning properly. If not, please refer 
to the “Contacting Customer Service” section of this manual. We’ll do our 
best to help you solve your problem. 
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Appendix D: An Introduction to  
Digital Recording 
 
 
Converting Sound into Numbers 
 
In a digital recording system, sound is represented as a series of  numbers, 
with each number representing the voltage, or amplitude, of a sound wave at 
a particular moment in time. The numbers are generated by an analog-to-
digital converter, or ADC, which converts the signal from an analog audio 
source (such as a guitar or a microphone) connected to its input into 
numbers. The ADC reads the input signal several thousand times a second, 
and outputs a number based on the input that is read. This number is called a 
sample. The number of samples taken per second is called the sample rate.  
 
On playback, the process happens in reverse: The series of numbers is 
played back through a digital-to-analog converter, or DAC, which converts 
the numbers back into an analog signal. This signal can then be sent to an 
amplifier and speakers for listening. 
 
In computers, binary numbers are used to store the values that make up the 
samples. Only two characters, 1 and 0, are used. The value of a character 
depends on its place in the number, just as in the familiar decimal system. 
Here are a few binary/decimal equivalents:  
  
 BINARY     DECIMAL  
 0000000000000000    0  
 0000000000000001    1  
 0000000000000010    2   
 0000000000000100    4  
 0000000000001000    8  
 1111111111111111    65,535 
 
 Figure A. Binary numbers and their decimal equivalents 
 
 
Each digit in the number is called a bit, so the numbers in Figure A are 
sixteen bits long, and the maximum value which can be represented is 
65,535.  
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Sample Size 
 
The more bits that are used to store the sampled value, the more closely it 
will represent the source signal.  In an 8-bit system, there are 256 possible 
combinations of zeroes and ones, so 256 different analog voltages can be 
represented. A 16-bit system provides 65,535 possible combinations. A 16-
bit signal is capable of providing far greater accuracy than an 8-bit signal. 
Figure B shows how this works. 
 

 
Figure B. The more bits there are available, the more accurate 
the representation of the signal and the greater the dynamic 
range.  
 
Darla24’s analog inputs use 24-bit ADCs, which means that the incoming 
signal can be represented by any of over 16 million possible values. The 
output DACs are also 24-bit; again, over 16 million values are possible. 
Darla24 processes signals internally with 24-bit resolution to insure that 
there is no degradation to the audio signal as it is processed through the 
system. 
 
The number of bits available also determines the potential dynamic range. 
Moving a binary number one space to the left multiplies the value by two 
(just as moving a decimal number one space to the left multiplies the value 
by ten), so each additional bit doubles the maximum value that may be 
represented. Each available bit provides 6dB of dynamic range. For 
example, a 24-bit system can theoretically provide 144dB of dynamic range. 
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Sample Rate 
 
The rate at which the ADC generates the numbers is equally important in 
determining the quality of a digital recording. To get a high level of 
accuracy when sampling, the sample rate must be greater than twice the 
frequency being sampled. The mathematical statement of this is called the 
Nyquist Theorem. When dealing with full-bandwidth sound (20Hz−20kHz), 
you should sample at greater than 40,000 times per second (twice 20kHz). 
Darla24 allows you to sample at rates up to 96,000 times per second.  
 
If the sampling rate is lower than the frequency you are trying to record, 
entire cycles of the waveform will be missed, and the result will not 
resemble the proper waveform. When the sample rate is too low, the 
resulting sound has diminished high frequency content.  
 

 
Figure C. Increased sample rates yield a more accurate 
reproduction of the source signal.  
 
By the way, the circuits that generate the sample rate must be exceedingly 
accurate. Any difference between the sample rate used for recording and the 
rate used at playback will change the pitch of the recording, just as with an 
analog tape playing at the wrong speed. Also, any unsteadiness, or jitter, in 
the sample clock will distort the signal as it is being converted from or to 
analog form.  
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Storing Digital Data 
 
Once the waveform has been transformed into digital bits, it must be stored. 
When sampling in stereo at 48kHz using a 20-bit word size, the system has 
to accommodate 1,920,000 bits per second. Though this is a lot of data, it is 
well within the capabilities of personal computers. 
 
Most computer-based digital recording systems record the data directly to 
the computer’s hard disk. Today’s hard disks are capable of storing large 
amounts of data, though the performance of hard drives can vary 
substantially. The Echo Reporter program (included on the Darla24 CD-
ROM) will give you a general idea what the capabilities of your hard disk 
are and how much information it can successfully store and retrieve. The 
speed and size of your hard drive will be a major determining factor in how 
many tracks of audio you will be able to simultaneously record and 
playback.  
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Appendix E: Specifications 
 
 
Audio Performance 
 
Analog in to analog out 
 

Frequency Response: 20Hz – 22kHz, ±0.5dB 
Input Stage Dynamic Range: 113dB 
Output Stage Dynamic Range: 116dB 
Input + Output Stage Dynamic Range: >108dB 
THD+n: <0.003%, 20Hz–22kHz, A-weighted 

 
Hardware 
 

Two ¼" TRS balanced analog inputs with precision 24-bit 128x 
oversampling analog-to-digital converters 
Eight ¼" TRS balanced analog outputs with high-performance 24-bit 
128x oversampling digital-to-analog converters 
Multiple sample rates up to 96kHz 
24-bit data resolution maintained throughout internal signal path 
+4dBu / -10dBV operation selectable per channel 
Low-latency input monitoring 
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